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Import Microsoft Word or
∗

OpenOffice documents

Mark Husband
Connexions
This work is produced by The Connexions Project and licensed under the
Creative Commons Attribution License †

Abstract
How to enter content into Connexions by importing Word documents (*.doc extension). Documents
may be edited in Microsoft Word, or an open source editor like OpenOce Writer that allows you to
save a document as *.doc.

1 Overview
One of the easiest paths for populating a module is the Word/OOo importer, which converts a *.doc document
to CNXML. The importer

overwrites

any existing CNXML, so it is most useful as an initial import.

We suggest using the online Edit-in-Place feature to make any further edits; any re-import of a Word or
OpenOce document will erase any other changes you have made using Edit-in-Place or the Full Source
Editor.

Who should use the Word/OOo importer?
You should use the Word/OOo importer if you already have a Word or OpenOce document saved that
you wish to publish to the repository.

The importer will correctly convert objects like section headings

(designated by innate Word/OOo styles like

Heading 1

or

Heading 2),

paragraphs (separated by two line

breaks), tables, lists, images, footnotes, and even mathematical objects.
You can go one step further and apply the special CNXML styles in our template to your document so
that you are able to import CNXML-specic objects like examples, problems, notes, citations, quotes, and
1

more. The Word/OOo importer can produce most of the CNXML

tags available for authors to use in their

modules (see What can I import? (Section 4: What can I import?) below) and several combinations of tags.
Any use case not available as a Word/OOo style must be added after import, either using the Edit-in-Place
interface (recommended) or full-source editing.

How does it work?
2

1. First you need to apply the CNXML styles from our template

to your document. We have sections

below with specic instructions for both Word (Section 2: Preparing documents in Microsoft Word)
and OpenOce (Section 3: Preparing documents in OpenOce Writer).
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2 http://cnx.org/help/authoring/templates/Connexions-Document.dot
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2. Next, you need to prepare your Word or OpenOce document for import. The importer will ignore
any user-dened styling, and requires specic markup in order to import other objects correct. We
recommend that you read through the What can I import? (Section 4: What can I import?) section
to learn what can be imported and make sure that your document has been properly prepared.
3. Be sure to save with a *.doc extension (Windows 97-2003 compatible).
4. Create a new blank module in one of your Work Areas.
5. Use the importer on either the

Edit

or

Files

tab to import your saved document.

2 Preparing documents in Microsoft Word
3

Download a copy of the document template (*.dot)

.

You may also want to download a copy of a sample document (*.doc)

4

that has been prepared to properly

exercise all the features of the template. We encourage you to have a look at the document and practice
uploading it (see "Uploading Your Document" (Section 5: Uploading your document)) to get a feel for how
the Word import process works.

2.1 Creating a new document with the template
To create a new document in Microsoft Word to import into Connexions, download and open either the
5

template

As.

or the sample document

6

from above. In Microsoft Word go to the

File

menu and select

Save

In the "Save As" dialog box that appears make sure that "Word Document (*.doc)" or "Word 97-2003

Save as Type drop-down box. Give your document a unique name in the File
Name box, and click the Save button. You have now created a new Word document with the template styles
(*.doc)" appears in the

included in it. Delete the default text from the template and begin typing your document, adding styles as
you go as described below.
Alternatively, you can install the template le into Word so that it is available through the
in the Word

File

New

option

menu. Instructions to install this template are specic to your version of Word, so we

recommend that you consult Word's Help feature if you wish to do so.

2.2 Applying Styles to an Existing Document
If you already have a document that you wish to import, you will need to apply the template styles to the
document. To apply the template to an existing document, rst open that document in Word. Then, follow
the steps below:

Tools menu and click Templates and Add-Ins.
Attach button, and use the le browser to navigate to the folder where you saved the template

1. Go to the
2. Click the
le.

3. Select the "Connexions_Document.dot" icon in that folder and click

Open.

4. In the Templates and Add-Ins window, make sure the Automatically Update document styles box
is checked and click

Ok.

(Figure 1 (Figure 1))

3 http://cnx.org/help/authoring/templates/Connexions-Document.dot
4 http://cnx.org/help/authoring/templates/WordExample.doc
5 http://cnx.org/help/authoring/templates/Connexions-Document.dot
6 http://cnx.org/help/authoring/templates/WordExample.doc
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Figure 1: Microsoft Word's template add-in window.

As an alternative, you can also create a new blank document with the Word Importer template styles as
described in "Creating a New Document with the Template" (Section 2.1: Creating a new document with
the template). Once you have done so, you can copy and paste the text from your original document into
the new blank document as follows. Go to the

Select All

option. Then go to the

Edit

Edit

menu in the original Word document and select the

Copy

menu in the original Word document again and select the

option. This copies the text of the original document to your system clipboard. Next, go to the
in the new blank Word document with the Word Importer template styles and select the

Edit

menu

Paste option.

The

text of the original document is now copied into your new document, and you can begin modifying it with
Word Importer style information as described in the next section.

2.3 Using styles in Microsoft Word
If you are using Microsoft Word 97, you can nd the style drop-down box on your format toolbar at the
top of the screen (it usually displays the default style

Heading 1 or Normal).

In newer versions of Word the

style menu is located under the "Home" tab. Click the pop-out icon in the lower right corner of the Styles
menu to see a list of all styles.

http://cnx.org/content/m13056/1.5/
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Figure 2: The Styles menu in new versions of Word.

To apply a style to a specic piece of text, you follow the instructions below:
1. Highlight the word, phrase, or paragraph you want to semantically mark up.
2. Locate the styles menu.
3. Click the name of the semantic style you want to apply to the highlighted text. The text that was
highlighted is automatically given the style you selected.

3 Preparing documents in OpenOce Writer
7

Download a copy of the document template (*.dot)

.

You may also want to download a copy of a sample document (*.doc)

8

that has been prepared to properly

exercise all the features of the template. We encourage you to have a look at the document and practice
uploading it (see "Uploading Your Document" (Section 5: Uploading your document) below) to get a feel
for how the Word import process works.

3.1 Creating a New Document with the Template
To create a new document in OpenOce Writer to import into Connexions, download and open either the
9

template

Save As.

or the sample document

10

from above.

In OpenOce Writer go to the

File

menu and select

In the "Save As" dialog box that appears make sure that "Word Document (*.doc)" or "Word

Save as Type drop-down box. Give your document a unique name in the
Save button. You have now created a new document with the template styles

97-2003 (*.doc)" appears in the

File Name box,

and click the

included in it. Delete the default text from the template and begin typing your document, adding styles as
you go as described below.

3.2 Applying the Template to an Existing Document
To apply the template to an existing document, create a new blank document with the OpenOce Importer
template styles as described in "Creating a New Document with the Template" (Section 3.1: Creating a New
Document with the Template). Once you have done so, you can copy and paste the text from your original

Edit menu in the original OpenOce Writer
Select All option. Then go to the Edit menu in the original OpenOce Writer
document again and select the Copy option. This copies the text of the original document to your system
clipboard. Next, go to the Edit menu in the new blank OpenOce Writer document with the OpenOce
document into the new blank document as follows. Go to the

document and select the

7 http://cnx.org/help/authoring/templates/Connexions-Document.dot
8 http://cnx.org/help/authoring/templates/WordExample.doc
9 http://cnx.org/help/authoring/templates/Connexions-Document.dot
10 http://cnx.org/help/authoring/templates/WordExample.doc

http://cnx.org/content/m13056/1.5/

Connexions module: m13056

5

Importer template styles and select the

Paste

option. The text of the original document is now copied into

your new document, and you can begin modifying it with OpenOce Importer style information as described
in the next section.

3.3 Using styles in OpenOce Writer
You can see the styles available to you with the template by going to the Format menu and selecting the
Styles and Formatting option. This brings up the "Styles and Formatting" box. Paragraph styles (such
as Heading 1, Heading 2, and CNXML Quote) are available by clicking on the leftmost icon at the top of the
box. Character styles (such as CNXML Emphasis, CNXML Code, and the rest of the application-specic styles)
are available by clicking on the second-leftmost icon at the top of the box .

(a)

(b)

Figure 3: (a) Paragraph styles. (b) Character styles.

To apply a style to a specic piece of text, you follow the instructions below:
1. Select the appropriate style from the "Styles and Formatting" box.
2. Make sure the "Fill Format Mode" tool is selected in the "Styles and Formatting" box (appears as the
paint bucket icon in thegure (Figure 3) above.
3. Highlight the text to which you wish to apply the style, and it will be applied.

4 What can I import?
•
•
•

Text markup using the template styles (Section 4.1: Text markup using the template styles)
Other objects (Section 4.2: Other objects)
Caution to users of MathType 5 (Section 4.3: Caution to users of MathType 5)

http://cnx.org/content/m13056/1.5/
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Some common mistakes (Section 4.4: Some common mistakes)

4.1 Text markup using the template styles
We can use the text styles provided by the template to generate Connexions text markup tags when the
document is imported.

Emphasis
The

CNXML Emphasis

11

style is used to give emphasis

to important text. Use this style where you would

have used bold or italics to emphasize particular words or phrases. Note that

boldface and italicized

text

will both import as an emphasis tag with the appropriate eect attribute.

Foreign
The

CNXML Foreign

style allows us to designate a term which is in another language than the rest of the

text. We can also point its usage at a website of our choice by marking it as a hyperlink in addition to

Foreign.

Code

12

This will produce foreign

With the
language.

CNXML

text in a module.

CNXML Code style, we can designate inline text as code13 written in a computer programming
CNXML Code (Block) to designate blocks of code that should be set o from surrounding

Use

text.

Cite
The

CNXML Cite

style allows us to refer to non-electronic sources.

If you are using Microsoft Word to

prepare your document, you can cite a hyperlinked source by marking it as a hyperlink and then applying

CNXML Cite.

Term

With the

14

This is produce a citation

CNXML Term

in Connexions.
15

style, we can designate key terms

in our document.

If you are using Microsoft

Word to prepare your document, you can also point this term at an example of its usage by marking it as a
hyperlink and then applying CNXML Term.

Quote

CNXML Quote (Block) style, we can designate a section of text as a block quote16 from another
Use CNXML Quote (Inline) to designate inline quotes that should not be set apart from the sur-

Using the
source.

rounding text. If you are using Microsoft Word to prepare your document, you could also point this at an
online source by marking it as a hyperlink and then applying

Hyperlinks
Using the

CNXML Quote (Inline).

Hyperlink style, we can create a hyperlink pointing to a URL. This will become a link17

element

in your Connexions module. We can also point at specic locations within the document by pointing, for
example, at any section title created using the

H1, H2, . . .

styles, or at any bookmark we have inserted into

the document.

Exercise

18

We can make exercises
style.

CNXML Exercise (Problem)
CNXML
CNXML Exercise (Solution).

that only have problems by marking them up using the

We can also make exercises that have problems and solutions by following the text marked

Exercise (Problem)

Theorems

with some more text marked
19

We can have theorems

Theorem (Statement)

with or without proofs.

style.

11 http://cnx.org/eip-help/emphasis
12 http://cnx.org/eip-help/foreign
13 http://cnx.org/eip-help/code
14 http://cnx.org/eip-help/cite
15 http://cnx.org/eip-help/term
16 http://cnx.org/eip-help/quote
17 http://cnx.org/eip-help/link
18 http://cnx.org/eip-help/exercise
19 http://cnx.org/eip-help/rule
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CNXML
CNXML
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Theorem (Statement)

Denitions

20

We can have terms

7

followed by

CNXML Theorem (Proof).

with denitions

21

Notes

We can create note

22

Examples

boxes using the

We can create example

23

CNXML Definition (Term)
CNXML Definition (Meaning) style.

. To do so, we mark the term using the

style, and we follow it with the explanation marked using the

CNXML Note

boxes using the

style.

CNXML Example

style.

4.2 Other objects
We can do more than just mark up text using the Word/OOo importer. We can also add images to our
document, create tables, add lists, and even insert mathematical expressions. . .

Sections

H1 applied to a section title produces a new section24 . The section lasts until the next H1-marked title.
H2-marked title in between produces a subsection (which lasts until the next H2- or H1-marked title).

An

Paragraphs

You can also use certain features of the Word or OpenOce editor to produce other CNXML tags. Pressing

Enter

25

gives a new line and produces a new paragraph

Images

You can insert images

26

.

into your Word document as you would normally, and they will import into

Connexions. It's best to stick to image types such as with .eps, .jpg, .png, and .gif (or any format with a
27

valid image type

); avoid formats such as .wmf and .svg, and avoid Clip Art.

Use only images that are locally available on your machine. Make sure either that (1) the images are
28

already available under a creative commons (CC) attribution license

, or (2) you own the image copyrights

and are willing to make them available under a CC attribution license.

Figure

CNXML Figure Title style to give
CNXML Figure Caption style to give them a caption.

We can precede images with text marked with the
follow them with text marked in the
a gure

Tables

29

them a title, and
This will produce

in the module.
30

Using the built-in Word table editor, we can create tables

Lists

31

We can create both bulleted and numbered lists

which are easily imported into Connexions.

using Word or OpenOce and bring them into Connexions

using the importer.

Mathematics

We can include mathematics in a line of text. Mathematics set o from other text in its own paragraph will
import as an equation

32

.

In OpenOce, choose

Insert > Object

from the menu and then select

20 http://cnx.org/eip-help/term
21 http://cnx.org/eip-help/denition
22 http://cnx.org/eip-help/note
23 http://cnx.org/eip-help/example
24 http://cnx.org/eip-help/section
25 http://cnx.org/eip-help/para
26 http://cnx.org/eip-help/image
27 http://www.duke.edu/websrv/le-extensions.html
28 http://creativecommons.org/licenses/by/3.0/
29 http://cnx.org/eip-help/gure
30 http://cnx.org/eip-help/table
31 http://cnx.org/eip-help/list
32 http://cnx.org/eip-help/equation
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In Word we can use the built-in Equation Editor 3.0. To do this, choose

Insert > Object

from the

menu and select Equation Editor 3.0. warning: It is very important that you insert and equation through
the
the

Object menu. Newer versions of Microsoft Word have an option
Symbols menu. Do not use this as it will not import correctly.

to insert an Equation, located under

Figure 4: Insert equations through the Object menu.

If you can't nd the Equation Editor 3.0 option in the list, you must install Equation 3.0 from your
Microsoft Oce installation CD. Please consult your Microsoft Oce help for more information on this
procedure.
warning: If you have MathType 5 installed on your system, math will not import correctly. See

below (Section 4.3: Caution to users of MathType 5) for how to remedy this.

Figure 5: Microsoft Oce object insert window.

http://cnx.org/content/m13056/1.5/
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Footnotes
Footnotes inserted using the native footnote tool will import as Connexions footnotes

Glossary

Finally, we can designate a glossary
with the

CNXML Glossary Section

34

33

.

section for our module. We must rst give it a title and mark that

style. This must be the last section designation used at the end of your

word document, and it cannot be followed by H1, H2, etc. styles. Then, for each glossary element we wish
to include, we mark the term portion with

Definition (Meaning),

CNXML Definition (Term) and the meaning portion with CNXML

as we did before in the body of our document.

4.3 Caution to users of MathType 5
MathType 5 is a stand-alone equation editing package written by Design Science, makers of the Microsoft
Equation 3.0 editor. When MathType 5 is installed on your system, equations written with the Microsoft
equation editor will be saved as MathType 5 equations rather than Equation 3.0 equations. Even merely
editing equations from a document with Equation 3.0 equations on a machine with MathType 5 will cause
those equations to be saved in MathType 5 format. This is problematic, since the Word importer cannot
properly convert MathType 5 equations to Presentation MathML.
We recommend un-installing MathType 5 from your system if it is currently installed. This will cause
Word to revert to using Equation 3.0 for equation editing, which will allow the Word importer to properly
generate mathematics.
Should you inadvertently include a MathType 5 equation in your Word document, in the Edit-in-Place
interface where the mathematics should appear you will instead see the warning message shown in Figure 5
(Figure 6).

Figure 6: Edit-in-Place warning for MathType mathematics import.

You can go replace each of these warning messages by hand using the following procedure. To begin,
double click on the MathType equation in Word to open the MathType editor.
If this is your rst time to use this procedure, you must congure MathType to properly generate
MathML. Go to the

Preferences

menu and select the

Translators

option. In the window that appears,

make sure that Translation to other language (text) is selected, and in the drop-down box next to Translator:, select the MathML 2.0 (m namespace) option. Also, make sure that Include translator name in
translation and Include MathType data in translation are NOT selected (see Figure 6 (Figure 7) below).
Click

OK

to complete the conguration. This sets the translation preferences permanently, so you will not

have to repeat these steps again.

33 http://cnx.org/eip-help/footnote
34 http://cnx.org/eip-help/glossary
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Figure 7: Setting the translator in MathType to copy MathML to the system clipboard.

Once the Translators preferences are set, you can copy the MathType equation's MathML equivalent by

highlighting the equation in the MathType editor and copying to the clipboard (Edit menu,

Copy

option).

This stores a copy of the MathML on your system's clipboard.
Return to your browser and nd the appropriate placeholder for the equation in the Edit-in-Place interface
(appearing as in Figure 5 (Figure 6)). Double click to edit the paragraph and delete the text ***SORRY,
THIS MEDIA TYPE IS NOT SUPPORTED*** (Figure Figure 7 (Figure 8) below). Paste the contents of
the clipboard into is place (Figure Figure 8 (Figure 9)), and click Save. Your equation should now appear
in the Edit-in-Place interface (Figure Figure 9 (Figure 10)).

Figure 8: Editing the paragraph with the warning text

Figure 9: Pasting the MathML copied from the MathType editor into the paragraph where the equation
should appear.

Figure 10: MathML equation appearing in the edit-in-place interface.

http://cnx.org/content/m13056/1.5/
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4.4 Some common mistakes
It is important that you follow the instructions on this page for each object. Do not use other objects or
text, including:
1. Do not add line breaks betwen paragraphs using

cntl-Enter.

This will not import as a new paragraph.

2. Do not use tabs. This formatting will not import.
3. Do not use lists or tables to invisibly format the document, as these constructs are literally imported
as lists and tables into CNXML.
4. Do not continue list numbering across separate lists.
5. Do not insert images whose source les are remotely available via a hyperlink.
6. Do not use Word's image captioning option; the caption will import as a new paragraph.
7. Do not use fonts such as Wingdings" to produce symbols: They will be interpretted as text.
8. Do not use the MathType editor inside Word to create equations.

This is the default (and only)

option if MathType is installed on your system. See the Notes on Including Mathematics (Section 4.3:
Caution to users of MathType 5) section for more details.

5 Uploading your document
1. If you have not already done so, create

35

a new blank module.

2. Use the help documents linked above to ensure you have prepared your document correctly; otherwise
you may get an error.
3. The importer dropdown menu is accessible on both the module

Content

Figure 11: The module import menu (expanded).

4. On the next page, browse to your saved le on your harddrive and click

Figure 12: Browse to le.

35 http://cnx.org/help/authoring/createmodule
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Files
Import

tab and the

editing the module. Choose the importer type from the dropdown menu and click

Import.

tab when

